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CONTROL® 10.3 — Overview

CONTROL®10.3 is all about putting more power to analyze, model, and present CONTROL®
data into the hands of any Excel user.

With the introduction of Flex views, you can insert rows, columns and cells, add calculations,
copy and paste, and format your view any way you like — all the while retaining the connection
of the data on your worksheet to the underlying CONTROL® data and meta-data.

In addition to Flex views, there are a number of improvements and enhancements to the
Information Navigator, and several refinements in object views and edit books to help make
the job of the administrator easier.

Enhancements for the Information Navigator

Flex views

With decades of usage by thousands of users in a broad spectrum of industries, it is fascinating
to observe the creative ways that CONTROL® data is used for business models, analyses, input
templates, reports, and presentations. This is a crucial element in the value equation that
CONTROL®brings to its customers.

Flex views are the next advance in empowering Excel users to access and manipulate
CONTROL® data for any purpose they can imagine — with the same security, data integrity,
and scope of applications that are the hallmark of CONTROL®.

In previous releases, we introduced scratchpads and Control Reference Functions (CRF) which
delivered additional functionality in this area. While these features have been used
successfully by many customers, they have limitations that restricted their use. Both features
also require a deeper knowledge of CONTROL® than a typical Excel user would have.

Flex views are designed to overcome these limitations.

The goal of this feature is to marry the richness and power of the CONTROL® architecture to
the familiarity, flexibility, and simplicity of Excel.

Here is just one example of a report that you can quickly create that references data from
multiple models using this new functionality:
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For a comprehensive review of Flex views, see the Flex Views document.

User navigation pane

After introducing the Object Navigation task pane in version 10.0, we received a lot of
feedback on how easy it is to find and edit various CONTROL® objects. In fact, it became the
preferred mechanism for administrators to choose and open books, views, and forms.

With 10.3, we are bringing the same convenience to Information Navigator users. The User
Navigation task pane allows you to quickly browse and navigate to the same kinds of objects
you can open from the CONTROL® Navigator ribbon.

The User Navigation pane shares the left-hand side of your screen with the Application Menu
and the Object Navigation pane:
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File Home Insert Page Layout Formulas Data Review View
[€ Login éﬂ J "C.)l ) Refresh - \ \ﬁ" 1 |:| F
[ Logout b .._ 75 Regenerate ~ % s r 9
Exchange Rate Books = Views __ Select  File Forms = 5h
wa COMTROL® Model ~ = + [ Solve Page Data~ -
Login Model T Books Views Forms | 5
C10 7 Jx
* 3 @ User Navigation - Mavericks.Clean103_Test - -4 1__
Type Category 2 |
Object Types ew 3 |
4 [ Structure ~| Search P 4
g.r_: Datasource D5 - CRF - Flex View conversion (Flexed) 2—
= Model SCA - OH Variance Report (ID: SCA_CH_V| ?_
4 [ Interface SCA - OH Variance Report (ID: SCA_OH_V| 8_
i Book SCA - Original Flex View JS g_
Form 202 Input Budget 10
b Shest 302 Input Budget 1
| 4 1) View 350_REV =1
= 500 Net Margin .
Computational 501 Standard Reports L
Source Data 503 Input Farecast Lad
Bill of Materials A bemarsce =]
Object 800 Public L2
Administrative 850 Security 1
Power Pivat 875 System 18
4 EmProcess 900 Development : ;{9}_
Seript || 950 Best Practice 571
2 Tronetorm —1% 1+ 990 Obsolete 2]
v | Favorite Objects Object Templates =
~ | Recent Views. 24_
(5] EXMP - Financial Statements - R " 23 |
€8] EXMP - Financial Statements - 5C 48]
&l EXMP - Financial Statements - 5C 27 |
k] EXMP - Financial Statements - 5C ;E—
(5] EXMP - Financial Statements - 5C = 30|
&) Global Rates - Flex View 21 |
[&] EXMP - Financial Statements - 5C 32 |
(5] EXMP - Financial Statements - 5C | 33 |
&) Revenue - RP - SCA - Performanc 34:
&) EXMP - Financial Statements - 5C 33 |
€&] EXMP - Financial Statements - 50 36
€8] EXMP - Financial Statements - 5C 57
Ig] Control Object Properties - Samp ¥ #|
< wm ] ’ < m > || P2
Ready ’|_'|

You select the class of object (view, book, etc.) and optionally the sub-class (computational,
source data, etc.) on the left, then choose a specific object of that class on the right side of the
pane or pick from the recent or favorite lists at the bottom.

K<

5

February 26, 2019



CONTROL® 10.3 Release Announcement

Double clicking executes the default action — opening a view, book, form or sheet; or running a
script or transform. Double clicking on a model or data source will open a new view on that

object.

Each object has additional actions, which vary by object class. These actions are found by
right-clicking on the object. For a view, the options are:

"

@

4 [g] View

Computational
Source Data
Bill of Materials
Object
Administrative

Power Pivot

4 [ Process

Script

2 Transform

¥ Favorite Objects

PR ]

T . 1 I

l

Rev - Flex - Kai - Add another Relative
Rev - % of Rev

Rev - Analytical

Rev - Analytical - Copy - Mugil

Open

LL

12
13
14
15
16

Open Read Only

Open the selected book, form, sheet or view.

Open With Review
Edit View Scopes
New

Copy
Edit
Delete
Universe

Properties

Add to Favonte Objects

o B e o e o = = e o R e R e R e e = e = e = R = -~ |

Rev - Basic test nested rows INPUT bug

o

19

gl
il

2
23
U
2
20
27
28
2

30
4|

A tool tip explaining the action appears when you hover over the action name.

The User Navigation pane offers a second organization of the components of your application

on the Category tab:
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+ & @ User Mavigation - Mavericks.Clean103_Test A S 4
200 Overheads Search 2
202 Input Budget 4 [ Structure o~
205 Maintenance ] Datasources
200 Payraoll 4 [ Models
302 Input Budget
305 M:intena:ce W COGS - PRCS
350, REV 4 P EXMP - Expense
500 Net Margin [T Data Sources
501 Standard Reports [ Transform
5032 Input Forecast 4 [ View —
505 Maintenance [T 800 Public
700 Maintenance 4 [77]900 Development
800 Public 2] Expense - HLF - Input Copy
830 Security I Performance Test
875 System 2] SCA - Expense - By Mon - Input
BT3_SYSTEM Ug) SCA - Expense - By Mon - Input - Flex ||
900 Development

| 950 Best Practice : Ug) SCA - Large Flex View - Read
999 Obsolete Ug) SCA - Large Flex View - Update
Object Templates [5] 5CA - Large View
k5] SCA - Large View - Read
k5] SCA - Large View - Read Copy
k5] SCA - Medium Flex View - Read
k5] SCA - Medium Flex View - Update
9] SCA - Medium View - Read
lg) SCA - Medium View - Update
lg) SCA - Small Flex View - Read
lg) SCA - Small Flex View - Update
lg) SCA - Small View - Read
lg) SCA - Small View - Update
[ Form
= EXMP - Expense by Year
= EXMP - Expense - Curve - HLF

This tab lets you pick a category on the left, and then navigate to a model, the data sources
mapped to or from the model, the views and forms used with the model, and so on. Thisis a
more natural structure for exploring unfamiliar applications.

To switch between the User Navigation pane, the Application Menu, and the Object
Navigation pane (if you are an administrator), use the drop-down list or right and left arrow
buttons at the top of the pane:

Sy

W - =+ IEIUserNavigatinn—Mavericks.CIeaMOB_Deu ¥ XK

Type Category m User Mavigation - Mavericks.Clean103_Dev

EI Object Mavigation - Mavericks, Clean103_Dev

@ Dernao Menu
200 Overhead Search o
350 Reve
- -—-——\.-\.uu-\._/g%—‘ —v"-'"/' m"\ﬁ"‘*u—/‘f\mmW’\
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Your administrator determines which panes you can see and your default pane by setting the

User Experience and Default Navigation properties of your user object:

H4F Properties for User The Chief Administrator

X

JA  Search

Class
Group
Description
4 Privileges
Allow Authenticated

Create Public Objects...
Default Object Categ...
Max View Size

New Passward Requir...
Password

User Type

User Experience

Default Navigation

Create Private Objects...

User
(Mong)
The Head Fromage AGAIN

EitherAuthentication
Development (I0: DEVELOPMENT)
]

[

EhkkkRkEhEy

ObjectManager

Super Administrator

Default Navigation Ll User Navigation Pane

Select what this user will see in th

Application Menu
Object Navigation Pane

User Navigation Pane

5R ?BI'ICE

New object browsers

For users accustomed to navigating via the ribbon, the object browser dialogs have been
redesigned to have a simpler yet more functional interface.

The differences are most visible in the Open View dialog:
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i Open a View
E Revenue - RP Search... =
Recents Name o] Description

&) EXMP - Financial Statements - Expense - Analysis @ Exmp - Rev EXMP_REV Prototype view used :
] _ In - Rev Yearly Target - On Rev M IN_REVYEARLYTARGET Prototype view used ¢
2] EXMP - Financial Statements - Demo - Interface Usage Property 1= Rev - % of Rev REV_OFREV Brototype view used
16 EXMP - Financial Statements - EXMP - Expense Report B Rev - Analytical EXMP_REV_ANALYTICAL Prototype view used ¢
8] Exchange Rate Model - Scotts test view = Rev - Basic EXMP_REV_BASIC Prototype view used ¢
Rev - Daily Sales REV_DAILYSALES Prototype view used :
Rev - Daily Sales by Customer REV_DAILYSALESBYCUSTOMER Prototype view used :
Categories Rev - Daily Sales by Product REV_DAILYSALESBYPRODUCT Prototype view used :
Rev - Glb Input EXMP_REV_GLBINPUT Prototype view used ¢
BalRevenne REV - Power Bl Report REV_POWERBIREPORT Prototype view used ¢
351 Revenue User Objects Rev - Brice - Change EXMP_REV_PRICE_CHANGE Prototype view used :

500 Net Margin

Rev - Ranked - One Scenario

EXMP_REV_RANKED_ONE_SCN

Prototype view used :

800 Public Rev - Ranked - Variance EXMP_REV_RANKED_VAR Prototype view used ¢
850 Security Rev - Scratchpad View REV_SCRATCHPADVIEW Prototype view used :
875 System Rev - SVA - Explained REV_SVA_EXPLAINED Prototype view used ¢
900 Development Rev - Variance EXMP_REV_VAR Prototype view used ¢
950 Best Practice Rev - xRate Actual - Var REV_XRATEACTUAL_VAR Prototype view used ¢
Object Templates Rev - xRate - Fest REV_XRATE_FCST Prototype view used :
Revenue - Actual Input REVEMUE_ACTUALINPUT Prototype view used :
Revenue - Forecast - Input REVEMUE_FORECAST_INPUT Prototype view used :
< ] [ >

Object Name Computational |'|
o

e The icons in the upper left corner let you select a model, data source, or object context

by launching an appropriate sub-dialog.

|
FEE

Select Model

Select Object

Select Data Source

e The search functionality now allows you to search through all the listed objects and
locate only the objects that match the ID or name you enter. The search can be done on
all the objects independent of category or can be limited to the selected category.
r'“l Open a View X

E Eﬂ E Revenue - RP Revenue
Recents Found Objects: (3 )
ta] Revenue - RP - Rev - Flex - LT- 01 Name id Category
(& Revenue - RP - Rey » Flex - Kai - List 1D Ravenue - Actual Input  REVENUE_ACTUALINPL 501 Standard Reports
& EXMP - Financial Statements - SCA - Worksheet 6 Revenue - Forecast - In  REVENUE_FORECAST | 800 Publc
o EXMP - Financial Statements - SCA - View Specifier - Works SCA - Revenue SCA_REVENUE 500 Net Margin
L EXMP - Financial Statements - SCA - Worksheet 1
VS 4
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e The Recents list now includes entries for all CONTROL® actions, including New,
Edit, Open, Run, Test, and Schedule.

e You can click on the Recents header to sort your pinned objects.

e When typing into the Object Name box, auto-completion logic will list valid options
for you.

Object Name rﬂ{
Rev - % of Rev A
Rev - Analytical

Rev - Basic

Rev - Basic Copy
Rev - Basic Copy
Rev - Daily Sales
Rev - Daily Sales by Customer

New drill to data

There is a new drill option that opens a view window on a new worksheet to help you explore
any part of a Computational or Flex view in greater depth.

The new window is looking at the same data as the original view but reorganized in a way that
provides greater detail without changing the configuration of the original view.

Here is an example of looking at Gross Sales in a 6-dimensional view:

ANV
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- - Scenario
Filters: (Actumls)
P' - Customer Product Adjustment
ages: (Tatal Customer) (Total Product) (Total Adjustme.)
A~ Revenue - RP | Actual Report
L’} Scenario | Actuals
COMPANY NAME . .
Comeary Sogen Customer | Total Customer : Praduct | Total Praduct :: Adjustment | Total Adjustment
NOTRANSLATION | Amounts not Scaled
Time Period
Revenue Account -Partial Total For
300_UNITS Units 659,340 672,527
-4000_PRICE Price 476 472
|| 4000 Gross Sales 3,1M,254.79 3,173,638.86
4500 Sales Discount 113,683.25 114,855.25
4400 Sales Returns and Allowances 91,980.45 92,928.70
4300 Shipping Charges 48,526.76 49,027.04 Copy Control Reference
4600 Other Incomes 45,645.72 46,116.29 4, Paste Options:
-400_REV Net Revenue 2,932,710.05 2,962,944.17 3, =
Insert...
Delete...
Clear Contents
Filter »
Sort »
'l Insert Comment
[# Eormat Cells...
Pick From Drop-down List..
Define Mame...
&, Hyperlink...
Drill - Down
Undrill > To Data
Compress 4 To Scratchpad
Expand 4 To Subaccount
M » »| Sheetl . Sheet2 | Actual Report .~ Sheetd %1 Hide » To Source

Like every other drill operation, highlight the cell or cells you are interested in, right click, and
select Drill > To Data:

NOTRANSLATION

Customer

+Asia

+Europe

+North America
-Total Customer

M F M| Sheetl

Filters:
P' - Revenue Account Time Period Adjustment
a ;l 3. {4000 Gross Sales) {Mar-18) {Total Adjustme.}
{\ Revenue - RP | Actual Report
L'Fb Scenario | Actuals
COMPANY NAM

Am|

Sheet2 | Actual Report(2)

Revenue Account | Gross Sales :: Time Period | Mar-18 » Adjustment | Total Adjustment

ounts not Scaled
Product
+Product Group +Product Group +Product Grou
0001 0002 0003 | -TotalProduct
519,120.00 296,010.00 274,095.00 1,089,225.00
549 270,00 304,335.00 284,400.00 1,138,005.00
470,880.00 282,690.00 257,607.00 1,011,177.00
1,539,270.00 333,035.00 316,102.00 3,238,407.00

Actual Report . Sheet3 . ¥J

A new worksheet is opened which presents the selected data in greater detail. You can:

e Navigate the view further on this worksheet — expand, show, rotate, etc.

e Enter data or perform solves — the original view will immediately reflect your updates.

4
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e Perform Drill > To Data (or other drill operations) from this worksheet.
e Close the drilled view window without altering your original presentation.

e Return to your original view and select Drill > To Data on other information, you wish
to explore.

Note: In previous releases, the option Drill > Data referred to drilling on an item in the
view and replacing the contents of the current worksheet with the drilled data. In release
10.3, this option is now Drill > Down.

Ranking and bucketing in analytic custom dimensions

You can now easily see the numeric rank of dimension members in a computational view as
compared to their peers — i.e. best store for sales, most profitable region, highest yielding
investment, etc. (This feature was released on a limited basis in version 10.2 and is now
generally available.)

Bucketing is very similar to ranking except that it divides the members into a specified number
of groups. For example, it is common to group in quartiles (4 buckets) or quintiles (5 buckets).

In the context of hierarchical CONTROL® data, it is important to be able to distinguish rank
and bucketing based on a level of detail. You typically would not want to compare the sales
within a territory or a region to the sales within a single store, but you would want to compare
a territory to other territories or a store to other stores. Ranking and bucketing allows you to
define the appropriate logic.

In support of this enhancement, analytic custom dimensions now support the following new
functions:

e Rank, RankUp, and RankDown. Rank is the same as RankDown, where a rank of 1
is assigned to the highest data value.

e Average, Median, Min and Max

e Quartile, Quintile, and Decile. The largest numeric values are in the lowest numbered
grouping.

e Bucket, BucketUp, and BucketDown. Bucket is the same as BucketDown, and these
functions are like Quartile except that they allow the specification of the number of
buckets. (Quartile has 4 buckets, Quintile 5, Decile 10)

The general format of these functions is:

rankingFunction[{member} %groupingOption On dimensionID] {In nBuckets}

ANV
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If the member is omitted, the Base member of the analytic dimension is used.
For example:
Rank[%WithinGroup On Product]
The grouping options are:
e 9%.Overall — all data in the dimension is included in a single ranking.
e %W.ithinGroup — data within a parent-child group is ranked.
e %WithinLevel — data within the same level is ranked, independent of parentage.

e For consistency with other analytic functions, %Total is the same as %Overall and
%Group is the same as %oWithinGroup.

The dimensional specification options are identical to those currently supported for all other
functions in analytic custom dimensions. The dimensionID can be a valid dimension ID, a
subclass name (Variable, Organization, Scenario, or Time), or Organization_n to select the nth
organization dimension-branch included in the view.

Here is a sample analytic custom dimension:

4+ [} X A ¥ [ Expanded view (Read Only]  Find

f RankDown[%WithinLevel on Organization]

ID: Name KCIMagicDimension Formulz
BASE: Base Data Base Dats (ID: BASE)
PERCENTOFYEAR: PercentOf Year PercentOf%Total on Time]
PERCENTOFORGGROUP: Percent of Org Group PercentOfl %Group on Organization]
PERCENTOFTOTALEXP: Percent of Total Exp PercentOATOTAL on Variatle]
PERCENTOFTOTALTOTAL: Percent of Total Total PercentOTCTAL ON Variable] IM [%Total on Time]
CHANGETOPRICR: Change te Prior Delta[%Prior an Time]
PERCENTCHANGETOPRIOR: Percent Change to Prior PercentDelta[%Prior on Time]
BWPRICR: BW Prior BWDelta[%Prior on Time]
BWPERCENTDELTA: BWPercentDelia BWPercentDeltalSPrior on Time]
RANKDOWNOVERALL: RankDownOverall RankDown[%Cverall on Organization]
RANKUPOVERALL: RankUpQverall RankUp[#Overall on Organization]
RANKDOWNWITHINGROUP: RankDavnWithinGroup RenkDa hinGraup an Organization]
RANKDOWNWITHINLEVEL: RankDownWithinLevel RankDa hinLevel on Organization]
AVERAGEWITHINGROUP: AverageWithinGroup Averag Group on Organization]
MEDIANWITHINLEVEL: ithinLevel Me thinLevel on Orgarization]
MINWITHINLEVEL: Mir nLevel on Organization]
MAXWITHINLEVEL: MaxWithinLevel a nlevel on Organization]
QUARTILEGVERALL: Quartileverall Quarile]%Overall on Crganization]
BUCKET3WITHINLEVEL: Bucket3WithinLevel Bucket{zWithinLevel On Organization] In 3

|z| 18 |Search

L

Key 107265
4 Definition

Formula /. RankDown[%WithinLevel on Grganization]

Maodlel Overrice (None)

Read Only

KCI_MagicDimension... A
4 Currancy

Update [E

ANV
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Here is

the view using this dimension:

Customer 0008
Customer 0007
Customer 0006
Customer 0005
Customer 0004
Customer 0003
Customer 0002
Customer 0001
USA United States
Customer 0026
Customer 0025
Customer 0024
FRA France
Customer 0023
Customer 0022
Customer 0021
A Ily
Customer 0020
Customer 0019
Customer 0018
“TWN Taiwan, Provin
Customer 0017
Customer 0016
Customer 0015
“THA Thailand
Customer 0014
Customer 0013
Customer 0012
ESP Spain
Customer 0011
Customer 0010
Customer 0009
~JPN Japan
Customer 0027
“CAN Ganada
Total Customer

Analytic Compare
“Average “Median “Min “Max “RankUp RukDow -RankDann “RankUp “RankDown “Rank Up ~Quartile “Bucket3
WithinGroup  Withinlevel  Withinlevel  WithinLevel Overal (o omgy WithinGrop  WithinGroup  WithinLevel  Within Level Overall Within Level
Customer Customer Customer Customer Customer Customer Customer Customer Customer Customer Customer

21628 13,166 24420 22,704 26,136 L 2 1 8 20 8 4 3
3,40 3160 14400 3704 1% 7 El 3 7 i 7 i 3
23,364 3160 24430 3704 %1% § i 3 § i § i 3
R 3166 1440 2704 1% 5 E 4 5 S 5 I 3
310 3166 41 704 1% 1 E 5 I ) 4 I 3
2968 3166 44U 2704 1% 3 ) § 3 = 3 [l 3
8% 3,166 141 704 513 [ S 7 1 i : i 3
704 3160 41 a0 613 1 3 8 1 i 1 i 3
18533 048 7446 2613 135,38 3 2 1 § i 8 1 1
26,004 BT 4400 32704 1% 7 i 1 3 2 3 [ 1
EX Bin 1440 2704 1% 2 1 2 2 3 5 ? 1
=740 B0 440 2704 1% u J 3 1 4 H : 1
T4l 41 74546 1% 135,38 M 3 2 7 2 7 1 1
25,608 25,476 40 2704 1% i 1 1 3 5 3 2 1
476 5410 41 a0 613 u 15 : 1 i b} 1 1
35,344 546 14410 3704 %1% i 16 3 1 7 i) 7 i
76,438 048 7446 2,13 135,38 3 [ 3 § 3 § 1 2
R 25,060 4400 3704 %1% ] 17 1 3 8 W 7 1
25,080 25,000 1440 2704 1% 1 1 2 2 8 1 ? 1
498 5,00 41 704 1% 1 1 3 1 1} 1 3 2
ce of China 75240 5,40 14546 1% 185,38 2 5 4 5 4 5 1 2
451 14604 440 i,704 613 Y ] 1 3 o 7 3 2
24184 24,84 24420 22,704 26,136 16 Pl 2 2 1 16 3 2
HE 24684 14400 3704 1% i i 3 1 1 15 3 :
752 418 7446 1% 135,38 3 § 5 4 5 4 1 2
440 4798 4400 32704 %1% 1 E 1 3 [ i 3 ?
2429 429 41 704 1% 5 ) : 1 15 b} 3 2
24156 2428 44U 2704 1% u = 3 1 16 2 3 2
71,864 1,41 14,546 6,13 135,38 ] T § 3 § 3 1 3
24024 13,802 24420 22,704 26,136 11 2 1 3 17 i 3 2
Y 3 14400 3704 1% 1 i 3 3 1 0 3 :
3760 B 24430 3704 %1% § £} 3 1 1} [ i 3
TLET 418 74546 %1% 185,38 u 8 7 2 7 2 1 3
1% 3513 440 32708 1% i [l 1 1 1 7 1 1
1% 41 74546 1% 135,38 il ] 8 1 8 1 1 3
559,340 50,340 §33,340 659,340 50,340 3 1 1 1 1 1 1 1

Some important details:

ANV

As with other analytic functions, keywords may be used and will be evaluated in the
model scope of the view.

The ranking values are based on the data in the view and are not dependent on the
orientation of the view.

Data is ranked without taking an absolute value, so negative values will get a higher-
ranking number in RankDown and a lower ranking number in RankUp.

Two members with identical data values will get the same ranking, and the member
with the next highest or lowest value will get a ranking 2 greater than the tied value.

By default, data which is identically zero is NOT ranked, as this can cause the memory
used to generate the view to grow dramatically. If you do need to have 0 values
included, use %oWithinGroupZeros, %WithinLevelZeros, or %OverallZeros as a
grouping option.

The Bucket functions require a suffix of In nnn, where nnn is the number of buckets.
For example, BucketDown[%WithinGroup On Product] In 3 will divide the
members of the product dimension into 3 buckets — high, medium, low.
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Comments and hyperlinks in analytic custom dimensions

This enhancement lets you show comments and hyperlinks in the body of your view, and use
standard navigation operations like expand, compress, rotate, and drill to present commentary
and data any way you like.

This new mechanism is an extension of analytic custom dimensions that were introduced in
version 10.2.

Analytic custom dimension may contain one or more members whose formula is either:
e Comments[baseMemberID]

e Hyperlinks[baseMemberID]

You can omit the baseMemberID if there is a member with the ID of BASE:

Dimension - Test Comment x| »
(03] 3= scaren £ + [0 X A v [ Expanded view (Read Only) Find £
i Hyperlinks
- ID: Name KCIMagicDimension Formula
KCl_Magic... BASE: Base Data Base Data (ID: BASE)
COMMENT: Comments Comments[BASE]
HYPERLINK: Hyperlinks Hyperlinks

Hierarchies Filters

Hierarchy Branch
KCl_MagicDimensic

E] = Find L
ID: Name:

BASE: Base Data

When you open the view with these members included, the comments and/or hyperlinks
display in the rows and columns of the data area. In the example below, the view includes
Comments.

Revenue Account ~Partial Total For Year 2018
Base Data -Comments Base Data -Comments Base Data -Comments Base Data -Comments
300_UNITS Units 3202
-4000_PRICE Price 9.10 9.1 538 5.8
[davesiNew Product Line started
this mon ith
[Administrative User]New Product
4000 Gross Sales SKU started in March
4500 Sales Discount [daves]Increase by 15%
4400 Sales Returns and Allowances
4300 Shipping Charges [daves]increase in gas prices
4600 Other Incomes
-400_REV Net Revenue 833133 8417.22 £,580.00 2333755

A few important implementation notes:

ANV
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e The ReadOnly property of the custom member will determine whether the comment or
hyperlink text can be updated

e The view scope’s Comment Content property determines how the comments will be
presented:

o All will show all comments with the user name in brackets preceding the
comment.

o Last will show the most recent comment with the user name in brackets.

o Anonymous will show the most recent comment without user identification.

e Partially unanchored comments cannot be shown in the body of the view

e Cell comments may be turned on, but should be used with caution when the comments
are updateable, as updates to the cell comments will generally override the comments

that appe

ar as data

Lookups in custom dimensions

Custom members can translate distinct values to text strings using the new Lookup Level
property of a custom member:

Dimension - Expense - HLF Input x »
(22] &= [ Hicrarchies Filters
] Hierarchy Branch
= Scenario [~]scenario -
Scenario )tz Fina o
- 1 1D: Name
- ACT: Actuals ~
-
Time Period FCST: Forecast
PLAN: Plan
e &
4+ [ ¥ A <~ [ Expanded view (Read Only)  Find Pl
ID: Name Scenario Time Period
Act|&MemberName(level(YR  Ad Hoc(SCENARIO HSLCT_SCN_ACT)  Ad Hoc(YR &PRIOR_YEAR) ~
Festj&Memberhamel{level(YF  Ad Hoc(SCENARIO FCST) Ad Hoc(YR 8&«CURRENT_YEAR)
Fest Adj|&MemberMame(Leve
Curve Ad Hoc(SCENARIO FCST) Ad Hoc(YR CURRENT_YEAR)
Fest Tgt]&MemberName(Leve  Ad Hoc(SCENARIO FCST) Ad Hoc(YR S«CURRENT_YEAR) =
Fest Tatjvs|PY Act
Fest Tgtjus|PY Act3
Bud|&MemberName{level(YF  Ad Hoc(SCENARIO &SLCT_SCN_CY_BL  Ad Hoco(¥R &CURRENT_YEAR)
Fest Tathes|CY Bud
Fest Tgthus|CY Budt -
[i=] 44 search
Madel Override EXMP - Expense - Curve - HLF (ID: EXMP_EXPENSE_CURVE_HLF) -~
Read Only [}
Lookup Level Curve (ID: HLF_CURVE)
Scenario Filter Ad Hoc(SCENARIO FCST)
TIMEPERIOD: Time Pe... Ad Hoc(YR CURRENT_YEAR) -y
Lookup Level
If this member's data values should be translated to character strings, specify the numeric level or attribute which will c...

B C D E F
2 Curve (Level)
3 Prototype object view (Dynamic) View
4 Updating: Clear an. t Filte
8l [ID Nam
¥ F10 [Even
8 f20 Ma-4-5
E
10
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The view displays the data the same way as a lookup level value for a variable.

Department
(CAN Canada)
EXMF - Expense | Expense - HLF - Input
Department | Canada
Expense -
HLF Inout
e Act Fest -Fest Adj Curve Fest Tgt
Year 2017 Year 2018 Year 2018 Year 2018
Full Time Equivalent 425 433 433
Total Employee Compensation | 58,588,304 | 58,817,787 | (1,817,232) f4-4-5 57,000,355
Travel & Entertainment 2,823,357 | 2,633,632 0 [4-4-5 2,633,632
Supplies & Services 4,481,568 | 4,499,122 0 [4-4-5 4,499,122
Communications & IT 655,839 658,408 0 [4-4-5 658,408
Freight & Shipping 787,007 790,000 0 [4-4-5 790,090
Occupancy 1,311,678 | 1,316,816 0 [4-4-5 1,316,816
Maintenance 483,759 987,612 Even 987 612
Insurance £35,839 638,408 0 |Even 658,408
Utilities 635,839 638,408 0 |Even 638,408
Depreciation & Amortization 2,951,277 | 2962836 0 |Even 2,962 836
Other Expenses 7345848 | 7,231,044 0 |Even 231,044
-Total Overhead Expenses 81,040,315 | 81,214,163 | (1,817,232) PRI 396,931

Important details:

e The custom member may be updateable, and if so, it must have base dimension
definitions that allow posting to updateable (lowest level, write privileged) members of
those dimensions.

e |f there is a lookup level defined for both a custom dimension and a variable dimension
in the view, the custom dimension’s lookup level will be used for the custom member.

e |If the custom member is expandable, then all the members resulting from the expansion
will use the same lookup level.

e As with variables, the lookup level may be a level or an attribute that has a numeric ID.

e The look up value is stored in the model based on the members defined in the view and
the members defined by the filter(s) of the custom member. Therefore, you should
create a different model to store the look up data value(s), or filter your custom member
to select unique members that are specific to your lookup value, so you do not
overwrite your model data.

In the example below, the Curve and Fcst Target members have the same filters for
scenario and time. Therefore, you need to define the Curve member with a different
model (Exmp — Expense — Curve — HLF). If not, then the data for both members would
overwrite each other. Alternatively, instead of using a different model, you could filter
for a different scenario, for example, Scenario Curve_Data.

ANV
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Expense - HLF Input (Dimension)
Prototype view for Dimension - Custom View
Updating: Clear and Insert Filter:

Name ModellD Read Lookup SCENARIO Selection TIMEPERIOD Selection
Only Level
Curve EXMP_EXPENSE_CURVE_HLF| N |HLF_CURVE [Filter(SCENARIO FCST) Filter(YR &CURRENT_YEAR)
Fest Target EXMP_EXP_HLF N Filter(SCENARIO FCST) Filter(YR &CURRENT_YEAR)

This is different from using look ups with variables because you cannot store data for a
custom member, but only by the filtered members defined in the custom member.

Solve on calculated members in custom dimensions

Specialized logic for performing Solve on members of a custom dimension which are defined
by formulas has been implemented in this release.

When a change in a computed custom member is detected, a one-dimensional solve is
performed to allocate the changes to the operands in the member’s formula. Any non-
computed operand, which is defined to be read only, is implicitly locked, as are any operands
defined with a lookup level. The solve process is recursive for any calculated operands.

After solving back to non-calculated custom members, the changes are propagated to the non-
custom “sub-views”, and the traditional solve logic is executed, respecting any implicit and
explicit locks and any solve patterns.

Note: Solve does not work on calculated members of analytic custom dimensions or on
calculated members defined with the Better/Worse (BW) function.

Here is an example of solving on the percent change for Bad Debt Expense.

Read Only Updatable Calculated Calculated

Column Column Colmn CoLumrn
BOD s FCOST
Wariance

F5 - Account

Bad Debt Expense 60,584 |

Bank Fees [S.DDCI]l

Commissions and Fees Expense 45,248 |

Legal and Professional Expense 42875 i

Office Expense 29,865 |

Supplies Expense, Office 49,653 37

Training Expense 69,853 315 0.4%
Supplies & Services 295,816 293,078 2,738 0.5%|

e Update Bad Dept Expense percent change from -1.0% to 5.0%.

n\J
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Read only Updatable Calculated Calculated
Column Column Column Column
T B RCST
- LY FCST ws CY =CY FCST ws CY
Budget Forecast -
Bl Ma::!gma Mar-2018 ey Budget
Var «
Bad Debt Expense 60,584 | ) i
Bank Fees tS,IJDﬂ}‘ i ) 38.4%
Commissions and Fees Expense 45,248 4 044 9 9%,
Legal and Professional Expense 42 875 ‘ 5,755 1.8%
Office Expense : 29,8565 542 1.9%
Supplies Expense, Office 4 49 653 4 (5,137 11.59%
Training Expense 69.853 N5 0.4%
-Supplies & Services 285 816 293078 | 2,738 0.9%

e Click Solve.

Formulas Data Review View CONTROL® Navigator

@x- GeH e 3

P Regenerate o
Views ~= = Select File  Forms Sheets Scripts Tran

Page Data~ ' z ~
fw Forms = Sheets = Scripts = Tran

e Since Budget data is locked only Forecast data is updated.

Read Only Updatable Calculated Calculated

Column Column Column Column
B0 vE LT
—EE Y FCSTws Y -CY FCST s CY
Budget Forecast P .
oo mﬁnm Mar-2018 S e
| Var
Bad Debt Expense
Bank Fees 5
Commissions and Fees Expense 4
Legal and Professional Expense 42 875 5,755 11.8%
Office Expense 20,865 582 a9
Supplies Expense, Office 49 653 5,137 -11.53
Training Expense 69,853 35 0.4%
-Supplies & Services 295,816 289477 6339 2 .“.‘éi

New CONTROL® ribbon commands
We added and removed some commands to the CONTROL® ribbons to support new functionality.

The CONTROL® Navigator ribbon includes a new Flex Pane command in the Show/Hide group
to display the Flex Pane to help manage Flex formulas.

K<
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=] s Bookl - CONTROL®

File Home Insert Pagelayout Formulas Data Review View [REQMGECHIEEREGIE CONTROL® View CONTROL® Developer Developer Add-ins @ Tellme.. Signin gﬂhare

L ‘ an g Refresh = B ) /3 — as) Opt

e Fe@y- RELS{ & OHE © & = T

[ Logout ) . 39 Regenerate - - N o P Help

Revenue Books  Views Select  File Forms Sheets Scripts  Transforms Menu  View | Flex Tasks Universe = Close Keywords
«« CONTROL® -RP~ - ~ il Solve Page Data~ - - - - Pane Pane Pane - ) About
Login Model & Books Views & Forms Sheets  Scripts | Transforms Show/Hide Workflow Display ' Actions 'Configuration Options ~
B12 h fe 37266645.6058416 7
A B ) D E F
» 2| [B] View - 5CA - Rev View X %
m | 4 Filters: 2D 2018 4 Data(*, EXMP_ADJ p[0], EXMP_CUST r{0], ~
E = - r B12 EXMP_PROD p[0], EXMP_REV_ACCT c[0],
ges: : TIMEPERIOD p[0])

g 2 i Pa J . ORIGINAL TOT_PROD 208 saaas

& N Revenue - RP | SCA - Rev View View Specifier -

v | 5] (—f) Scenario | Budget 2018 EXMP_ADI EXMP_ADY p[0]

& | cowmue " i

g| 7 | Adjustment | Original :: Product | Total Product :: Time Period | Year 2018 EXMP_CUST EXMP_CUST r{0]

% [ 9|usD | Amounts not Scaled EXMP_PROD EXME_PROD pi0]

2 |10

E EXMP_REV_ACCT EXMP_REV_ACCT [0]

es Dis

é 11 . and Allowance TIMEPERIOD TIMEPERIOD p[0]

3 | 12 | Total Customer 37,266,645.61 34,286,692.81 13,131,053 1,629,168.78 13075347 | || || ——————

= 13 | CAN Canada 3,023,510.17 85 520,510 126,800.38 105,882.66 .

§ | 14 |ESP Spain 5,224 830,00 1,451,118 22632174 184,268.52 [ #8 Absolute -]
T | 15 |FRA France 5,796, 706.83 1,545,753 24413163 203,184.29 In Use . Search o
2: 16 | ITA Italy 5,653,750.85 1,522,098 239,679.16 198,455.35

t | 17 [JPN Japan 55,802.07 1,427,460 2,436.23 197143 Name Argument Value

% 18 | THA Thailand 218,982.49 1474779 9.414.50 7,710.20 SCA - Rev View -

° 19 | TWN Taiwan, Province of China 227,328.79 1,498,438 9,703.46 7,991.51
[u] 20 |USA United States 17,065,681.50 3,690,891 770,681.68 598,070.79

£ (2]

: |z

= 3| Editvalue | Resolve

5 | 24|

.:fn 25 | Apply to cell B12 Is Flex () Is CRF | Show Flex H
<5

@ | - -

& = Immediate update Update
= ‘ Sheet1 | SCA - Rev View O] [ 3 c i
Ready {15 i m - 1 + 9%

The CONTROL® View ribbon includes several new commands. The new Flex View group includes
commands to manage Flex views.

W& R e

Flex Show Revert Protection
Flex - State -

Flex View

In the Format group, we replaced Filter and Page Rows with the Repeat Member Names command.

= Suppress Zero Rows 1;31 Scale Factor |1 EEE Repeat Member Names - —
: Suppress Zero Cols & Row-Title Offset 0 "® Specify View Headers
v Exceptions e Expand Multi-page Jo) Excel Formulas -

Format

Users did not use the Filter and Page Rows command enough to warrant its placement on the
ribbon. However, users requested the Repeat Member Names command, so they can easily repeat
member names with nested dimensions.
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9 |USD | Amounts not Scaled 7 9 |USD | Amounts not Scaled

10 Revenue Accaunt | 7 10 | Revenue Account |

1 Product Customer Gross Sales 11 Product I Customer Gross Sales

12_ Product SKU 0001 --TataICustomer 3,234,254.11 12_ Product SKU 0001 -Total Customer 3,234.254.11

13 | *CAN Canada 240,242.20 13 | Product SKU 0001 *CAN Canada 240,242.20

14 *ESP Spain 452,781.86 14 | Product SKU 0001 *ESP Spain 452,781.86

15 *FRA France 465,969.68 15 | Product SKU 0001 *FRA France 465,969.68

16 *ITA Italy 462,672.73 16 | Product SKU 0001 *ITA Italy 462,672.73

17 *JPN Japan 4,935.57 17 | Product SKU 0001 *JPN Japan 4,935.57

18 | *THA Thailand 18,605.86 18 | Product SKU 0001 *THA Thailand 18,605.86

19 *TWN Taiwan, Province of China 18,949.96 19 | Product SKU 0001 *TWN Taiwan, Province of China 18,949.96 'Y

20 *USA United States 1,570,096.24 20 | Product SKU 0001 *USA United States 1,570,096.24 1,273,307

21 | Product SKU 0002 Total Customer 5,101,188.22 21 | Product SKU 0002 -Total Customer 5,101,188.22 4,617,052f

2 *CAN Canada 399,952.51 22 | Product SKU 0002 *CAN Canada 389,952.51 362,59

23 | *ESP Spain 714,779.91 23 | Product SKU 0002 *ESP Spain 714,778.81 548,031,6°

24 | *FRA France 770,168.76 24 | Product SKU 0002 *FRA France 770,168.76 698,2362

25 “ITA Italy 756,321,355 25 | Product SKU 0002 *ITA Italy 756,321.55 685,604

2% *JPN Japan 7,696.59 26 | Product SKU 0002 *JPN Japan 7,696.59 6,977.0

27 *THA Thailand 29,724.55 27 | Product SKU 0002 *THA Thailand 29,724.55 26,906

28 "TWN Taiwan, Province of China 30,628.21 28 | Product SKU 0002 *TWN Taiwan, Province of China 30,628.21 2776764

29 | "USA United States 2,391,916.13 29 | Product SKU 0002 *USA United States 2,391,916.13 2,160,805

30 | Product SKU 0003 ~Total Customer 3,028,310.61 30 | Product SKU 0003 -Total Customer 3,028,310.61 2,798,917,

3 "CAN Canada 233.474.82 31 | Product SKU 0003 *CAN Canada 233,474.82 215,821,4°

2 “ESP Spain 424,208.25 32 | Product SKU 0003 *ESP Spain 424,208.25 392,133

33 "FRA France 450,583,89 33 | Product SKU 0003 *FRA France 450,583.89 416,514
SR VRNV WL, o0 BN SNA W e W Ly u g AL N e S argzsn| i

Formatting a book’s table of contents

You can now format the Table of Contents (TOC) template worksheet to have alternating row

style formatting.

SI. No. Worksheet
1] In - xRate

2] SCA-OHExp

4] SCA - Rev View

3] SCA - OH Exp Input

TABLE OF CONTENTS
Contents Description
In - xRate
SCA - OH Exp
SCA - OH Exp Input

SCA - Rev View

Follow these steps to set it up:

1. Open a Template sheet that includes the TOC worksheet.

B

(COMPANY NAME

TABLE OF CONTENTS

5. No. Worksheet
&Pagel] &PagelWorksheethName

Contents Description

&PagelContentName &Page1Description

Frint Book

&BookName

TOC Banner| ®

2. Highlight the column header row and the next row below it.

K<
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S

CQMPAN\;NM‘E
Cormpury Siogn

Print Book

Sl. No. Worksheet
&Pagel] &PagelWorksheetName

TABLE OF CONTENTS

Contents

&PagelContentName

&PagelDescription

3. From the Home tab, click the Font Settings dialog launcher to open the Format Cells

dialog.

View CONTROL® Mavigator CONTROL® Sheet

Sheet - CONTROL®

CONTROL® Developer Q Tell me what'¥

Insert Page Layout Formulas

L PR
0 J cut Segoe Ul - - A A
o ER Copy ~

aste

- ¥ Format Painter Ty

Clipboard 7] Font )

B9 & fe | Sl.No.

[
I
¥

E—f Wrap Text General

Merge & Center ~ $ 9% o

0

0 0 Conditional Format as || Calculation

Formatting > Table~

= ’_:,‘l Normal 2 MNormg

Mﬂ,f

)

COMPANY NAME
Cermpany Sopan

5l. No. Worksheet
&Pagel] &PagelWorksheetName

|E! User Navigation - Mavericks.Clean103_Test |E| ¥

- Mavericks.Clean103_Test

i
&

Alignment [F] Mumber [F]
Format Cells I_-
‘ Mumber I Alignment Font ! ‘ Border | Fill | Protection
Font: Font style: Size:
Segoe Ul
T Seript MT Bold ~ | | Regular ~| |8 ~
T Segoe Print Italic 9
Segoe Script Bold
g EBold Italic
C T Segoe Ul Black
al T Segoe Ul Emaji h |14 v
Underline: Color:
Automatic E‘Bormalfent
Effects Preview

D Strikethrough
D Superscript
D Subscript

This font style is imitated for the display. The closest matching style will be used for printing.

NN AV AV NAVASVAN fJ»lml-J\fl_

4. On the Border tab, under Presets, click None.

R T NN m{ﬂﬁ*\JW—\j\.wﬁu\J\/‘\,w-\w MMJ

Format Cells

B

Line

Presets

ANV

Mumber Alignmentl Font | Border | Fill |Pmtectic|r1

MHone

Dutline  Inside

L,.-\,'——'\I:‘l"'—\bw_f"_\v_/r’!h"
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5. On the Fill tab, under Background Color, click No Color.

)
Format Cells \_-|
| Mumber | Alignment | Font | Border | Fill | Protection
Background Color: Pattern Color:
| No Cajor | Automatic v
] Hn *?r e FPattern Style:
. [
|
HEN
EEEEEEENEN
=, AEEEN EEN

6. Click OK to save the changes.

7. From the Insert tab, in the Tables group, click Table.

=

PivotTable Recommended Table F'icture?}
PivotTables b {"

Tables \'E\

8. On the Create Table dialog, select the My table has headers option, and click OK.

Create Table _

Where is the data for your table?
=5B59:5H510 EMg

My’ table has headersi
| o

K || Cancel |

9. You can use the default table style, or from the Table Tools Design tab, you can select a
different predefined format, or create a new table style.

nss
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Table Tools

CONTROL® Developer i 2@ Tell me what you want to do...

WA

Table Styles

Note: Excel will add generic column names to any columns with no header, so you will
need to change the font color to match the fill color for those column headers.

10. After defining the table style, you can either save the active Template sheet, or save it as a
new Template sheet.

Sheet1 - CONTROL®

CONTROL® Mavigator Co

1
=) _d o
’
=a LT
i Forms  Sheets Scripts Transi:orrhg

- - -

( Forms i Open Transformsr%

U Mew
,E"I Save
H Save As [}

2 Edit

o ~ "\

i
)
lE'p Print
-

Delete :ONT@‘

PagelContentMName

When you open a book that includes a table of contents, you will see the alternating row
styles.

ANV
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&

CONPENY NANE
Carmgaty Sogin

TABLE OF CONTENTS

| |n-xRate In- ¥Rate

1 SCA-CHE SCA- OHExp
3] SCA-OH Bip Input SCA - OH Exp mput

4 SCA-RevView SCA - Rev View

Print Book

§.No. Workshest Contents Destription

=

Enhancements for the administrator

Restoring applications using a code

One of the key goals of the re-imagining of the administrative interface in version 10 was to
dramatically reduce the amount of time and effort required to build a sophisticated CONTROL®
application.

KCI has been investing heavily in creating rich application templates for common financial
applications — revenue planning, expense analysis, capital budgeting, employee cost projection,
and more. We want our customers and prospects to share the benefits of this investment.

The manifest feature supports shipping collections of models, views, mappings, and other objects
between CONTROL® installations, but each customer will have their own chart of accounts,
product lists, and organization structures that needs to be “plugged in” to the application template.

To support the customized replacement of selected objects, we enhanced the manifest Restore
From > File option to allow the substitution of object IDs when you restore them from a
manifest. You define the replacement value by specifying a Code on the target system as shown
below:

nss
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#«s Restore Objects - DIMENSIONS.DCF X
Selected objects will be restored from the selected source.
Name D Class Subclass
Employee - Test EXMP_EMPLOYEE_T Dimension Organization
Payroll Expenses -1 EXMP_PAYROLLEXP Dimension Variable
Employee - Test EXMP_EMPLOYEE_T Hierarchy Organization
Payroll Expenses -1 EXMP_PAYROLLEXP Hierarchy Variable
ehtem Pronades. ¥
i=| 44  Search
“ Identification A
Name Payroll Expenses - Test
ID EXMP_PAYROLLEXP_TEST
Last Updated Tuesday, December 11, 2018 12:57:56 PM
“ Definition
Ohiect o Fayrolt Experees = Test (19: EXMP PAYROLEEXETEST)
Specified by Object ¥ | (0 Database (@ File
Manifest File |EADimensions.dcf \

The Code object specifies a list of source (or base) object IDs to be replaced with the matching
target object IDs using the {Object Class Name}Object ID format as shown below:

K</
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@HA9-c-F0s Smart Replace Code - CONTROL® 2 g %
Home Insert Pagelayout Formulas Data Review View CONTROLZ Navigator CONTROLE View CONTROL® Developer | CONTROL® Code | Developer Add-Ins & o o @ R

Name Smart Replace E-ETavget Table Correspondence One (Target)... ~ .Prcperties e 21 ﬁobjed Access ’- B
D SMARTREPLACE B2 Base Table [ 1s Allocated & [g storage [ }
- Code Mappings Utility -
Code Type Table To Table > Pane - Scripts + | L@ Changes ‘
Code Info Table - Table Properties Show/Hi... | Construction| Utilities Maintenance Displ...| Code|
Al v (8 e | Pages: v
» A B c b | E é‘ [D] Code - Smart Replace LS fees
W Pages: Target Table: [1] [1] Base Table
Ly !
o e i AT
3
§ il Find P Find o
= Properties |
6 x
~ 7. {Dimension}XYZ_EMPLOYEE_TEST {Dimension}EXMP_EMPLOYEE_TEST
o s {Dimension}XYZ_PAYROLLEXP_TEST {Dimension}EXMP_PAYROLLEXP_TEST]
ﬁ 9 {Dimension}XYZ_TOTAL_EMP_TEST  {Dimension}EXMP_TOTAL_EMP_TEST
& |
10| {Hierarchy}XYZ_EMPLOYEE_TEST {Hierarchy}EXMP_EMPLOYEE_TEST
p| 11 {Hierarchy}XYZ_PAYROLLEXP_TEST {Hierarchy}EXMP_PAYROLLEXP_TEST
b 12 {Hierarchy}XYZ_TOTAL_EMP_TEST {Hierarchy}EXMP_TOTAL_EMP_TEST
¥ |=
£ | 13 {Level}XYZ_EMPLOYEE_TEST {Level}EXMP_EMPLOYEE_TEST
5 o
2| 24| {Level}XYZ_PAYROLLEXP_TEST {Level}EXMP_PAYROLLEXP_TEST
EI 15| {Level}XYZ_TOTAL_EMP_TEST {Level}EXMP_TOTAL_EMP_TEST
e
| 17
3|18
P dl|
19| Expand Wildcards
g 20
© |l S - 24 [] Immediate update Update
v | M ¥ M| Code Structure . “Mappings . %J 4 il » pds
Book opened ] |@@g 90% @70*@ 4

The recommended steps to accomplish the creation and distribution of large-scale applications is:

1. Build the application in a development environment, creating new objects as needed and
using existing objects such as variable, scenario, and time dimensions as needed.

EXAMPLE - Revenue Model Built in Development Database Environment:

Used Dimensions <
Scenario Organization
= =]
= =1 - .
-
=1 - - w1
- =)
Scenario Customer Product
Variable Time
L
= =1}
L]
=1
Revenue Time Period
Account
Dimension De ¥

K<
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2. Identify the objects that need replacing to customize the application for the target
environment — such as account, product, or employee dimensions and the related levels.
We will call these Placeholder objects.

EXAMPLE - Revenue model built in development database environment:

<

Account

- g -
Scenario Customer  Product
——xm -y -
Placeholder Objects L’ il -
(Dimensions & Hierachies)
, T -
/

______ / =
| [ -
I - 1/ m
| =
I Revenue Time Period
I
L

«

3. Create a manifest in the development environment containing all the objects required for
the application except the placeholder objects. Store the manifest in a DCF file.

EXAMPLE: For this example, all the replacement objects (Dimensions & Hierarchies)
for the Revenue model already exist in the target database environment. The manifest
file will only need to contain the Revenue model object to restore into the target
database environment. The Code object created in step 4 will take care of identifying
the “placeholder” objects (in the development database environment) and the
“replacement” objects (in the target database environment)

4. Inthe target environment, create a Code object that lists the placeholder objects in the
Base column and their replacement objects in the Target column. Create any replacement
objects that do not already exist.

ANV
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EXAMPLE: Code object created in the target database environment

[D] Code - RESTORE - Model X »
Target Table: [1] [1] Base Table:
Column: I ]'] Column: I ]'I
Find R Find Pl
["] Expand Wildcards

[ Immediate update

| 4 A | B | C L 1[+]
2 | |RESTORE - Model (Code) U
3 | |Prototype object view (Dynamic) View
4 |Updating: Clear and Insert Filter:
67 Target
7] {Dimension}XYZ_CUSTOMER {Dimension)EXMP_CUST
8_ {Dimension}XYZ_PRODUCT {Dimension}EXMP_PROD
9 | {Dimension}XYZ_REVEUNEACCOUNT |{Dimension}EXMP_REV_ACCT
10 {Hierarchy}XYZ_CUSTOMER {Hierarchy}EXMP_CUST
1] {Hierarchy}XYZ_PRODUCT {Hierarchy}EXMP_PROD
12] {Hierarchy}XYZ_REVEUNEACCOUNT  |{Hierarchy}EXMP_REV_ACCT
13 {Model}XYZ_REVENUE {Model}EXMP_REV_PRCS
14
15
[ 16]
17
18]
19]
20 | v
Code Structure | Mappings | @ i [« D

Selected objects will be restored from the selected source.

Restore Item Properties

14 |Search

4 ldentification
Name
D
Last Updated
4 Definition
Object Info

Default Restore Behavior

Subclass

Revenue - PRCS
EXMP_REV_PRCS
Tuesday, July 17, 2018 12:55:47 PM

|Revenue - PRCS (ID: EXMP_REV_PRCS)

Behavior

Restore From

[ Specified by Object

[~

| ) Database (@ File

K<

Restore the manifest DCF file in the target environment, specifying the Code you created.
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EXAMPLE: Revenue model restored into target database environment

Scenario 'xvz - :'XYZ -
|_Cu_st2m_er_ _||Product
E)) ol SEe
Replacement Objects l—l’ 2
(Dimensions & Hierachies)
______ 7 e
= ’ :

«

Miscellaneous enhancements

Scenario hierarchy object view rollup style

We changed the rollup style of the Scenario hierarchy object view in both the dimension and
hierarchy edit books from “Tree” to “Table”. This aligns it with the same rollup style used for
Organization hierarchies, which improves the administration of multi-level scenario
dimensions.

Dynamic hierarchy books

You can create dynamic hierarchy books for both organization and variable hierarchies. These
books are very useful for managing hierarchies that include several primary branches. The
books include a table of contents, a workbook sheet for instructions, and objects views, which
generate automatically, for each branch.

There is an example of a dynamic organization hierarchy book in the 950 Best Practice
category named EXMP - Customer - Dynamic Hry Book.

Required objects

Object Views:

Organization hierarchy books: You need object views for both Branch and Root
rollups.

Variable hierarchy books: You need object views for VVariable rollups.

In addition, you will need one object view named Full Rollups.

ANV
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Note: These object views are generic and reference any branch. You do not need to create
object views for specific dimension branches.

Example object views: BranchRollups1, BranchRollups2, BranchRollups3,
RootRollupsl, RootRollups2, RootRollups3, VariableRollupsl, VariableRollups2,
VariableRollups3, Full Rollups, etc.

Sheet (Template):

The GLB - TOC & Banner - Dynamic Hry Book template.
Note: We will provide you with these objects upon request.
How to create a dynamic hierarchy book

You can create a new dynamic organization or variable hierarchy book by filling out the
following book properties in a new book.

e Dynamic Behavior: DefineOnOpen or DefineOnOpenAndRegenerate
e Dynamic Definition: FullRollups(Hierarchy(EXMP_CUST))

Note: EXMP_CUST in the Dynamic Definition above represents an Organization
Hierarchy ID

e Template Sheet: GLB - TOC & Banner - Dynamic Hry Book

ANV
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# Properties for Book EXMP - Customer - Dynamic Hry Book
‘7:\ 44 Search
4 Identification
Name EXMP - Customer - Dynamic Hry Book
D EXMP_CUSTOMR_DYNMCHRYBOOK
Class Book
Subclass Looseleaf
Category (None) ¥
Description Use this for a Looseleaf Bock with a Table of Contents
“ Definition
| Dynamic Definition FullRollups(Hierarchy(EXMP_CUST)) I
Edit Object (None)
Edit Object On File {None) -
s Edit Book
4 Structure
Book Structure Binary
Is Onfile Scope True
Sheets Are Linked E
User Scope All Users (ID: All Users)
“ Display
Display Contents Sheet 5]
| Template Sheet GLB - TOC & Banner - Dynamic Hry Book (ID: GLB_TOCBANNER_DYNHRYBK) v |
4 Parameters
Kevword Collection (None) hd
Dynamic Behavior
For dynamic books only, the book content will be defined when the book is open. (Regeneration does not apply to books.)
|T| ‘ Cancel

Adding a sheet object to a dynamic hierarchy book

You can add your own sheet to a dynamic hierarchy book by editing the dynamic
hierarchy book object and adding the sheet to the Content of the book. You can
determine the position that the sheet appears in the book by filling out the Property
Overrides property using the following Transient Property syntax.

Syntax

Used to

_Position =1

Put the Sheet in the first position (assumes origin 1)

_Position = Front

Put the Sheet in the First position

_Position = Front + 1

Put the Sheet in the second position

_Position = Back

Put the Sheet last

_Position = Back - 1

Put the Sheet second from the last

ANV
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Book - EXMP - Customer - Dynamic Hry Book X »
FS
RO Computational Views Search L
gg Source Data Views 700 Maintenance A
m Object Views 800 Public ‘,E

) 4 950 Best Practice

Ay ! 2 .
#X Administrative Views EXMP - Financial Statements

q Forms With Views i EXMP - Revenue
: Forms Without Views PRCS - Revenue
" Sheets EXMP - FS SubAcct - Org
EXMP - Payroll >
X ¢
Content Type Model or Data Sourct

EXMP - Instructions  Sheets

«

s |E| 34 Search

“ Definition
Content Type Sheets
Content EXMP - Instructions (ID: EXMP_IN v [
Auto Open [
Object View Compon... (None) v |3

Component Group (None) v

Dont Resolve Keyword L}

Property Overrides _POSITION = FRONT

Meta Object Info EXMP - Instructions (ID: EXMP_IN
“ Display v

Property Overrides
Optional overrides for any view properties, of the form [propertyNamel
= valuel][propertyName2=value2]..
Examples: _Position=Front
_Position=Back
ReadOnly=TRUE
SampleOnly=FALSE

[] Immediate update | Update H Maximize \

Note: With variable hierarchies, if you have levels with the Is Sorted property set to As
Listed, then you may want to create and add additional object views for those levels. This
way the user can add a new account to the level first, in the required position, and then
update the hierarchy. You can add these level object views to the dynamic hierarchy book
as well, and use the Property Overrides property to display these object views before the
hierarchy object views. See the example below.
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Book - Variables Hry Update x »
3
o Computational Views Search L
Bo ) 8110 T29 HISTORICAL REPORTS -
='q, Source Data Views
ADMIN MAINTENANCE
E Object Views AWARD-structure cbjects
‘(& Administrative Views “ EXPENSE
- Gemini Expense
E Forms With Views Adjustments
|:| Forms Without Views High Level Reparts
,. Object Templates
) Sheets ! P
Payroll
Public N
X oAV &
Content Type Maodel or Data Scurce
Instructions - Variables Hierarchy Sheets
I Variables Object Views Variables I
?
34 Search
AU UpEn N
Object View Compan... (Mone) ¥
Component Group (Mone) =
Dont Resolve Keyword
Property Overrides “
Property Overrides
Opticnal overrides for any view properties, of the form [propertyMame = value1]
[propertyNameZ=value]...
Examples: _Position=Front
_Position=Back
[] Immediate update

)

COMPANY NAME
Compary Sogan

Print Book

BOOK: Variables Hry Update

No. Worksheet

TABLE OF CONTENTS
Contents Content Description

Instructions - Variables Hierarchy

Model/Object Description

1] Instructions-Dimension Diagrams

2] VARIABLES (Level

Variables Manage Variables

3] Expense-3 levels

VariableRollups1 Branch Expense-3 Levels

Variables (Standard Hierarchy)

4] Board RPTS-Variable

VariableRollups2 Branch Board RPT5-Variable

Variables (Standard Hierarchy)

5] Expense Model Old Variabl

VariableRollups3 Branch Expense Model Old Variables

Variables (Standard Hierarchy)

6] Board RPTS Old Variables

VariableRollups4 Branch Board RPTS Old Variables

Variables (Standard Hierarchy)

7] Eull Hierarchy

Complete Bottom to Top Hierarchy with all

Full Rollups
P Levels (Read Only)

Variables (Standard Hierarchy)
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